
Verde Valley Computer Club 

See the September/October 2011. VVCC  Events Calendar on page 3 

  

 

Saturday  9:30 am 
 

In presenting this program, the Verde Valley Computer Club is neither implying an endorsement of any product 

offered nor validation of any information provided."  

DEADLINE FOR ARTICLES:  

TUESDAY, 

September 20 

2:00 PM 

 

 

Check your Verde Valley Computer Club 

website for details 

www.vvcclub.com  

While you are checking out the 

Newsletter for your 

information, take some time and look 

through the photos and look at the handouts 

for the SIG’s 

Lotsa interesting info there 

http://www.vvcclub.com


 

VVCC Mentors 

Adobe Photoshop Elements 

Marny Zuercher 

marny71@gmail.com 

Front Page 

Miles Standish: 

frontpage@vvcclub.com  

Windows 

Bob Efros: 646-9182 

bob@refros.com  

Word  2007 

Marny Zuercher 

marny71@gmail.com 

WordPerfect 

Marny Zuercher 

marny71@gmail.com 

Word Processing 

Richard Gohman 649-4388 

word-processing@vvcclub.com 

Photography 

Hal Rosenwasser 

photography@vvcclub.com 

Spreadsheet 

Richard Gohman: 649-4388 

word-processing@vvcclub.com 

              2011 OFFICERS 

  

  President: Jerry Miller 

  Vice President:  Bob Efros 

  Treasurer: Myrelle McHale 

  Secretary:  Barry Adico 

CALENDAR OF 

VVCC EVENTS 

Windows SIG 

Word Processing SIG 

Linux SIG 

Digital Camera SIG 

General Meeting 

*SEE MAP ON BACK PAGE* 
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VVCC Contacts 

president@vvcclub.com 

vicepresident@vvcclub.com 

secretary@vvcclub.com 

treasurer@vvcclub.com 

past-president@vvcclub.com 

sig@vvcclub.com 

programs@vvcclub.com 

equipment@vvcclub.com 

membership@vvcclub.com 

editor@vvcclub.com 

publicity@vvcclub.com 

 
 

 

Won't you volunteer for a 2012 Office? 

 
President 

Vice-President 
Treasurer 
Secretary 

 

Without these four the Club can not exist. 

Contact Bob Efros 

vicepresident@vvcclub or  call 646-9182 

Send your 30 dollar renewal 

to: 

Verde Valley Computer Club 

c/o Membership 

P.O. Box 3023 

Cottonwood AZ 86326-2540 

mailto:marny71@gmail.com
mailto:frontpage@vvcclub.com
mailto:bob@refros.com
mailto:marny71@gmail.com
mailto:marny71@gmail.com
mailto:word=processing@vvcclub.coml.com
mailto:photography@vvcclub.com
mailto:word-processing@vvcclub.com
mailto:president@vvcclub.com
mailto:vicepresident@vvcclub.com
mailto:secretary@vvcclub.com
mailto:treasurer@vvcclub.com
mailto:past-president@vvcclub.com
mailto:sig@vvcclub.com
mailto:programs@vvcclub.com
mailto:equipment@vvcclub.com
mailto:membership@vvcclub.com
mailto:editor@vvcclub.com
mailto:publicity@vvcclub.com
mailto:vicepresident@vvcclub.com
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President’s  Bits and Bytes 

Hi Everybody, 
I presume all of you search the web, and probably have your favorite way of doing so. Never-

theless, I though it would be fun to share a few tidbits and prejudices I‟ve picked up over time 

about that subject. As you most likely already know, the most popular search engines are 

Google, Bing and Yahoo (powered, by the way, by Bing). I will talk about them, and also a few 

others. 

I used to use Google exclusively, but I have gradually moved away from it, mostly because 

they save your searches for long periods of time, like months and years, for so called research. 

Frankly, I think my searches should not be saved at all. Why is it Google‟s business, or anybody who has access to 
Google‟s files to save my or your searches. (For more info about this you may start with the following links: http://
www.malwarehelp.org/understanding-search-engine-privacy-and-how-to-prevent-snooping-part-i-2008.html , http://
www.google.com/privacy/faq.html , http://news.cnet.com/2100-1029_3-6202068.html , http://duckduckgo.com/
privacy.html ) All the major search engines save your info in one degree or another. In any event, no matter which 
search engine ones uses, there are a few things you may find useful. Before I use any search engine, I go to their set-
tings page first and make a few changes. In Bing, starting in the upper right hand corner, go to: Preferences/results/drop 
down arrow (select 50), next check the box named „open in new browser window‟/Save. Now when you do a search, fifty 
results will be listed, instead of the default of ten. This saves a lot of time waiting for the next ten to load, and makes it 
easier to find what you are looking for when it is not in the first ten results. Also, by opening in a new window, your 
search is not lost, but stays on the original page for quick reference and usage. While you are on the preferences page, 
you may as well check out the other settings you have control over, for greater personalization. 

In Google, it used to just as easy to set preferences, but today I cannot find a link to do so. You may have better luck 
than I. Regardless, there is a surefire work around way to set your preferences in Google. Go to: http://www.google.com/
preferences . Change the „number of results‟ (note that Google gives the option of 100 results, which is what I would se-
lect), and „results window‟ option to „Open search results in a new browser window‟, plus „save preferences‟ and you are 
good to go. 

Yahoo is similar, with a few extra steps, which I‟m sure you will be able to figure out, if you have done Bing and/or 
Google by then. 
Any search result link can be opened in the same window in a new tab by simply right clicking over the link and selecting 
from the offered menu „Open link in new tab‟. If you are looking for something within a single website, the formula for the 
search bar is: query word: URL. So, for instance if you wish to search the Project Gutenberg for books that include the 
word diesel, their search engine will give you three results. However, if you use Google directly and type in:[diesel: http://
www.gutenberg.org/wiki/Main_Page] without the brackets, per the above formula, you will get 14,000 results. Whether 
that is an advantage or not is up to you, but it does show you an example of a website only search. This is most helpful 
with those occasional websites that do not offer a search option. 

I did want to briefly mention a few other search engines. DuckDuckGo.com states that it does not save or share any  
information (see link above). I tried it and it was easy to use, had useful results, had lots of interesting preferences, and 
was altogether a serviceable search engine. Scroogle at http://www.scroogle.org/ runs your search through their website 
for Google results, but with random IP addresses that are deleted within 24 hours, so it is impossible for Google to have 
any way to connect you with any search. Thus solving the privacy issue in a unique way. Yandex.com is a Russian 
search engine in English. It works pretty well and can give some different and interesting results. What attracted me to it 
is an option to search with the search results. For example, I did a search for Project Gutenberg and got 3 million  
answers. Clicking on the check box „search within results‟, entering „diesel‟ in the search bar, and clicking „search‟ again 
resulted in 27,000 results. A definite improvement. Also, results can be set to provide twice the preview info than other 
engines, so you can have a better idea if it is what you want or not. DuckDuckGo has that function also. Enough for now. 

Have Fun, 
Jerry Miller President VVCC 

http://www.malwarehelp.org/understanding-search-engine-privacy-and-how-to-prevent-snooping-part-i-2008.html
http://www.malwarehelp.org/understanding-search-engine-privacy-and-how-to-prevent-snooping-part-i-2008.html
http://www.google.com/privacy/faq.html
http://www.google.com/privacy/faq.html
http://news.cnet.com/2100-1029_3-6202068.html
http://duckduckgo.com/privacy.html
http://duckduckgo.com/privacy.html
http://www.google.com/preferences
http://www.google.com/preferences
http://www.gutenberg.org/wiki/Main_Page
http://www.gutenberg.org/wiki/Main_Page
http://www.scroogle.org/
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Membership Corner by Myrelle McHale 

Hello All, 
 
What an eye-opening program we had in August Thanks to Sgt. Gareth  
Braxton and Detective Chad Sinn we now have more avenues to protect our 
identity and not fall victim to fraud and ID theft. We thank these officers and our 
Cottonwood Police Department for sharing this knowledge with us. 

Each day there is more to learn about how computers can help us in our daily lives. If you have a 
topic you feel we could present that would be enlightening to other members, please let us know. 
We are open for suggestions and always ready to bring the latest in technology to you. You can 
send your suggestions to: programs@vvcclub.com OR info@vvcclub.com OR  
membership@vvcclub.com 

We will respond and take your suggestions to the next level. 
 
For those of you who may not be aware, once a month we have a Board of Directors meeting to 
discuss everything from possible future programs to how to increase our membership to staying 
current with all our existing offers to increase and share our technological knowledge to those who 
want to expand their own exposure to new 'tricks' to learn. This meeting is held on the first  
Thursday of each month, 6:30 pm, in the Board Room at the Clemenceau Building, corner of 
Willard Street and Mingus Avenue. We would love to see more of you attending. 
 
We also have some awesome mentors who are more than willing to share their wealth of 
knowledge with you. If you have any questions, please feel free to attend any/all of our Special 
Interest Group (SIG) meetings. They are about to start up again. Yes, we DID take a short summer 
break but we are ready to come back and bring new information to you. 
 
To bring you current with the offerings your Club has for you, please check out our Web Site: 
www.vvcclub.com 

You can check out the day/time of your favorite SIG and you can see photos of some of our  
meetings of the past (who knows – maybe YOU might be in the pictures!) 
 
Something we are always trying to increase, besides attendance at our meetings, is the  
membership of our Club. Recently an offer went out to the last-year members who did not renew. 
It is an offer I think is really hard to refuse. That offer is good through September 30, 2011. If you 
would like more information on this offer, contact me at: membership@vvcclub.com I will be more 
than happy to answer you as soon as possible. 

Now I know the heat has been pretty harsh on us lately so I will leave you with this comforting 
thought: Christmas is less than 4 months away and it will be much cooler before we know it. 
 
Bye for now. It was so nice to see so many of you at the meeting. Hope to see you again on  
September 17 at the next General Meeting. 
 
Myrelle   

mailto:programs@vvcclub.com
mailto:info@vvcclub.com
mailto:membership@vvcclub.com
http://www.vvcclub.com/
mailto:membership@vvcclub.com
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View More Than Two Areas Of Worksheet 

other than by hiding rows 

Applies to Microsoft Excel versions: 97 | 2000 | 2002 | 2003 

 

  ******************************************************************************** 
    Treasurer's Report as of July 31, 2011 
 
   Balance in the checking account is: $2,721.77 
 
  Anyone wanting further information, please accept our invitation 
  to attend the Board of Directors Meeting of the Verde Valley  
  Computer Club on the first Thursday of each month. We meet in 
  the Board Room in the Clemenceau Building, corner of Mingus Avenue 
  and Willard Street. Time: 6:30 PM. 
 
  Thank you. 
  *************************************************************************************** 

The easiest solution is to just open additional windows for the worksheet. Choose Window | New 
Window. Excel opens additional windows that contain the exact same worksheet. You can then 
choose Window | Arrange to arrange the windows any way desired. 

When you open additional windows in this manner, the windows are independent of each other, 
meaning that you can scroll them independently. If you make a change in one window, the same 
change is made in all the windows. (This makes sense, since they all display the same data.) 

Once the windows are situated the way you want them, you could save the arrangement as a view 
(View | Custom Views). That way you could quickly recall the appearance of your windows any 
time you desire. 

Applies to Microsoft Excel versions: 2007 | 2010 

The easiest solution is to just open additional windows for the worksheet. Display the View tab of 
the ribbon and click New Window in the Window group. Excel opens additional windows that 
contain the exact same worksheet. You can then click Arrange All in the Window group of the 
ribbon to arrange the windows any way desired. 

When you open additional windows in this manner, the windows are independent of each other, 
meaning that you can scroll them independently. If you make a change in one window, the same 
change is made in all the windows. (This makes sense, since they all display the same data.) 

Once the windows are situated the way you want them, you could save the arrangement as a view. 
(Display the View tab of the ribbon and, within the Workbook Views group, click Custom Views.) 
That way you could quickly recall the appearance of your windows any time you desire. 

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission.  
Thousands of free tips can be found online at http://tips.net 

http://tips.net/
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Changing your Antivirus – Antispyware Software 
R. Gohman Aug 2011 

 

So, you want to change the antivirus-antispyware software program on your computer? Maybe your 
subscription on a paid program is about to expire and the company wants big $$$ to extend the subscrip-
tion. Or maybe your brother-in-law (or the guy in the long coat selling watches off his arm) has recommend-
ed at better program. Or just a cheaper or even free antivirus-antispyware program. For what ever reason 
that you want to change, here are the basic steps you should follow. 

First: Go to the Internet, or your friendly software store, and obtain a copy of the new antivirus-
antispyware program installation files. If you purchase a boxed program at the store, the installation file will 
be on a CD or DVD disk. 

If you go to an Internet site, you have to download the installation file. When downloading an Antivi-
rus-Antispyware program from an Internet site, do not! I repeat do not choose the RUN option. Choose 
the SAVE option and choose a place on your computer hard drive to store this file. I have folder in my “C” 
drive for downloads. Some people have a folder in their “Documents” folder for downloads. Some people 
just download to the “Desktop”. 
 
  I discourage novice computer users from using the Desktop because they forget to move the 

  file after they have used it and leave it on the Desktop. Then several months later they don’t 

  remember why that ICON is on the desktop and they double click it again and start a new 

  installation of what by then is an out-of-date version. 

 

 Second: Now that you have the new program installation file, you have to “uninstall” the old antivirus 

program you were using. Having two antivirus-antispyware programs running on the same computer is not a 

pretty sight. They fight each other. That is why you did not choose the RUN option when you downloaded a 

new antivirus program off the Internet. 

  Windows has software to uninstall programs and Ccleaner has a similar program to remove 

programs. Unfortunately, most of the antivirus programs are so deeply imbedded in your computer that nei-

ther of these uninstall program really get all of the old program parts out of your computer. I recommend 

that you go to the web site of the old program, link to their “Support” page and search for an uninstaller writ-

ten by that company. I know Norton, McAfee, Panda, Avast & AVG all have such programs. Download their 

uninstaller for your program to your hard drive and then RUN it. 

  Be aware that as you start the uninstall operation you are removing the protection that is 

keeping the bad guys out of your computer. Since at this point, you have all the files you need off the Inter-

net saved to your hard drive, so you may want to disconnect your link to the internet. (Unplug the cable to 

the modem/router or turn of the wireless tool on your laptop.) 

 

 Third: When the uninstall operation is complete you may be asked to restart the computer. 

That advice should be followed as the restart clears the “Registry Files” of the old program information. 

When the computer is back on, now go to installation file you saved for the new program (or insert the CD 

you bought) and start the new program installation. At this time you may want to reconnect your computer to 

the Internet as the new program will want updates. Just don‟t do a lot of Internet surfing until the new pro-

gram setup is complete and reports that you are protected. 

Most antivirus-antispyware programs require some configuration setting to pick time and date for scanning 

and updating. If you are unfamiliar with setting up the new program, use the “Help” menu. That is what it is 

for. 
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VVCC Beginners 

Class  
 

A popular series of six hands-on sessions 

designed for the beginning computer us-

ers. Classes are held on Wednesdays 

from 4:15 to 6:15 PM at the Cottonwood 

Middle School Computer Lab, Mingus & 

6th.  

More information is on our web site!  

Please call  Barbara Wall at 567-4222 

to preregister for each series of  

classes 

The Series repeats. 

NO Classes 

until further notice 

 

VVCC Mailing Address: 

 

Mail  inquires, suggestions 

and items of interest,  

to the club,  

 

Verde Valley Computer Club 

PO Box 3023 

 Cottonwood, AZ 86326-2540 

 

Or  e-mail us at 

info@vvcclub.com 

Arranging Workbook Windows 

 

Applies to Microsoft Excel versions: 97 | 2000 | 2002 | 2003 

1. Choose Arrange from the Window menu. Excel displays the 
Arrange Windows dialog box. 

2. Make sure the Tiled option is selected. (This divides the 

screen space evenly between all your windows. The main 
benefit is that all your workbook windows get at least a 
piece of the screen.) 

3. Click on OK. The windows are all displayed. 

4. Click on the window whose size you wish to adjust. It  

becomes active. 

5. Move the mouse cursor near the border of the active  
window. When the cursor turns into a set of arrows, press 
the mouse button and drag the window edge to the desired 
size. Release the mouse button. 

Repeat steps 4 and 5 for each window you want to adjust. 

 

Applies to Microsoft Excel versions: 2007 | 2010 

If you have more than one workbook open at a time, Excel  
allows you to view all the workbooks at the same time and to 
arrange each window as you desire. The easiest method of  
arranging workbook windows is as follows: 

1. Display the View tab of the ribbon. 

2. In the Window group click Arrange All. Excel displays the 
Arrange Windows dialog box. 

3. Make sure the Tiled option is selected. (This divides the 

screen space evenly between all your windows. The main 
benefit is that all your workbook windows get at least a 
piece of the screen.) 

4. Click on OK. The windows are all displayed. 

5. Click on the window whose size you wish to adjust. It  

becomes active. 

6. Move the mouse cursor near the border of the active  
window. When the cursor turns into a set of arrows, press 
the mouse button and drag the window edge to the desired 
size. Release the mouse button. 

Repeat steps 5 and 6 for each window you want to adjust.. 

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. 

Thousands of free tips can be found online at http://tips.net. 

mailto:info@vvcclub.com
http://tips.net/
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Join Us for a  

Special Interest Group 

(SIG) 

Learn from each other! 

Visit our Web site for schedule 

and handouts 

Digital Camera:  
Leo Zuercher  

Linux 

Miles Standish 

Spreadsheets: 
Richard Gohman 

Windows:  
Bob Efros 

Word Processing: 

Richard Gohman  

 

Handouts for the sessions 

can be printed from the club 

website: 

www.vvcclub.com 

 

 

Beginner Classes: 
Barbara Wall 

Web Site Team: 
Bob Efros 

Richard Gohman 

Dave Olson 

. 

Secretary’s Corner 

By Barry Adico    

 

Jigsaw Puzzle 
Dale Forbes 

 
OfficeMax 8 Sheet Shredder 

Burnetta Ooley 

 
OfficeMax 8 Sheet Shredder 

Christine Cauiola 

 
Polaroid 12 MP Digital Camera 

Phyllis Haworth 
 

 
 
 
 
 
 

Editor’s Note: 

Monthly winners should thank our ‘super shopper’ Ned 
Pritchard for the  wonderful prizes he finds. Suggestions for 
future prizes would be a great help. Keep in mind the cost 

due to limited funds. Thanks 

 

http://www.vvcclub.com
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Using Early Dates 

Applies to Microsoft Excel versions: 97 | 2000 | 2002 | 2003 | 2007 

There are three basic types of information that can be stored in a cell: numeric 
values, strings (text), and dates. In reality, dates are nothing more than numeric 
values, with the number being stored representing the number of days (and  
partial days for the time portion of a date) since January 1, 1900. This is a quick, 
handy way for Excel to store dates. 

What happens, however, if you are doing genealogy or historical work and you 
need to keep track of dates that are earlier than 1/1/1900? There are essentially 
three ways you can approach this problem. 

First, you can split up your dates. You could, for instance, include three columns 
for each date: one for day, one for month, and one for year. This, of course, will 
not allow you to change display formats for different date notations, but it will  
allow you to sort (using the column contents) as you desire, and to do  
rudimentary math on the dates. This approach to early dates can be the easiest 
to implement. 

Another option is to use your own date notation for entering dates. For instance, if 
you wanted to enter the date for April 25, 1885, you could enter it as 18850425. 
This would be treated as a numeric value by Excel, which means you could do 
math based on the numbers. Because the notation has the year first, you could 
easily sort dates according to need. The only drawback to this method is that you 
cannot use Excel‟s date formatting, and you must get used to the notational  
syntax. 

Finally, you can either create your own macros to work with out-of-range dates, or 
you can use a third-party solution. One such solution is found at John  
Walkenbach's site: 

http://j-walk.com/ss/excel/files/xdate.htm 

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission.  

Thousands of free tips can be found online at http://tips.net. 

http://j-walk.com/ss/ecel/files/xdate.htm
http://tips.net
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Splitting Your Spreadsheet Window Into Panes 

 

Applies to Microsoft Excel versions: 97 | 2000 | 2002 | 2003 

You already know that Excel allows you to open multiple  
spreadsheets at the same time. You can also, however, divide a 
spreadsheet window into panes (as Microsoft calls them). These 
panes can be used to view two or four different parts of the 
same spreadsheet. You can split the worksheet both horizontally 
and vertically. 

To divide a spreadsheet window into panes, you use the divider 
bar. There are two divider bars. The first is located in the  
upper-right corner of the spreadsheet window, just above the 
vertical scroll bar. The second is located in the bottom-right  
corner of the spreadsheet window, just to the right of the  
horizontal scroll bar. 

When you position the mouse pointer over a divider bar, it 
changes to a different type of pointer. Click on the divider bar 
and drag it to where you want the spreadsheet window divided. 
If you want to divide the spreadsheet window in half (either  
vertically or horizontally), you can simply double-click on the  
divider bar. 

Another way to divide the worksheet into panes is to choose the 

Split option from the Window menu. This divides the worksheet 

into four panes. 

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission.  

Thousands of free tips can be found online at http://tips.net. 

http://tips.net/
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NO Beginners Classes until further notice 

 

Keep informed and refer to the newspapers, 

the website  www.vvcclub.com 

and the Newsletter, Connections 

Note from the Editor… 

The next newsletter deadline 

for all submissions: 

Tuesday: 

SEPTEMBER 20, 2:00 p.m. 

 

Verify your e-mail  

is correct. 
 Send corrections or  

changes to  

membership@vvcclub.com  

@ 

 

 

 

 

Tell your friends and neighbors 

to read the Connections at 

www.vvcclub.com, 

select Newsletter 

 

PLEASE WELCOME   New Members 

Roland DeMond 

Rose & Richard Sperry 

Hillie Triebess  

 

Thank you for joining our Verde Valley Computer Club 

http://www.vvcclub.com
mailto:membership@vvcclub.com
http://www.vvcclub.com

